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ABOUT THE COLONEL'S BEQ
The COLONEL'S BEQUEST is different from many
adventure games. It can best be described as an
interactive play in 8 acts. You will play the entire game
in one location, on an isolated island in a bayou. Events
can take place throughout that locale at any time during
the game, and they may occur whether you are present
or not.

At the end of each Act, a clock will appear on your
screen and strike the hour. It will also appear at other
intervals during the game. Take note of the events
which cause this to happen, and your location at the
time it occurs, as this will help you to keep track of your
progress. Being in the right place at the right time can
be invaluable.

Also, if you have thoroughly explored a room, don't
assume that the next time you visit the room things will
be the same. While you are exploring another area,
someone else may enter the room and leave a valuable
clue for you to find!
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CAST OF CHARACTERS

Laura Bow
Laura is a 20 year old
journalism major at
Tulane University in
New Orleans. A I920's
ingenue, she's studious
and down to earth,
energetic and
courageous. She's known
for her inquisitive nature,
probably acquired from
her father, a detective on
the New Orleans Police
force.

Colonel Henri Dijon
Henri Dijon is a gruff old
southern-style colonel.
He's wealthy, eccentric
and reclusive. He lives
alone except for his
servants; Jeeves, Celie
and Fifi, and his pets. He
was wounded while
serving with distinction
in the Spanish-American
war.

Lillian Prune
Lillian is Laura's college
classmate and the
Colonel's niece. Her
personality can be
described as extroverted
and rebellious. She
drinks, smokes and dates
several young men. She
dresses in the style of the
1920's flapper.

Rudolph Dijon
Rudy is Gertrude's son,
Gloria's brother and the
Colonel's nephew. He
gives the impression of
being a little too slick.
Rudy is known as a
gambler, a womanizer
and a lush. They say he's
never wprked an honest
day in his life.

Ethel Prune
Lillian's mother and the
Colonel's younger sister,
Ethel is known Tor her
whimpery, whiny nature.
You can usually catch
her in a rather tipsy state,
and she gives the
impression of being
quite helpless.

Gertrude Dijon
Gertie is the widow of the
Colonel's younger
brother. She's known as
money grubbing,
snobbish and bossy. She
has a fondness for
jewelry. . . especially
pearls.

Gloria Swansong
Gertie's daughter and the
Colonel's niece. An
aspiring actress, Gloria
enjoys the glamorous
Holly woodlife-style.
She's a beautiful
platinum blonde, and
loves money, jewelry
and rich boyfriends.

Jeeves is the Colonel's
tall, silent butler. Very
imposing and solemn,
he s not terribly friendly
or helpful. What is he
really after?
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Lillian is Laura's college
classmate and the
Colonel's niece. Her
personality can be
described as extroverted
and rebellious. She
drinks, smokes and dates
several young men. She
dresses in the style of the
1920's flapper.

Gloria Swansong
Gertie's daughter and the
Colonel's niece. An
aspiring actress, Gloria
enjoys the glamorous
Hollywood life-style.
She's a beautiful
platinum blonde, and
loves money, jewelry
and rich boyfriends.

Rudolph Dijon
Rudy is Gertrude's son,
Gloria's brother and the
Colonel's nephew. He
gives the impression of
being a little too slick.
Rudy is known as a
gambler, a womanizer
and a lush. They say he's
never worked an honest
day in his life.

Clarence Sparrow
Clarence is the Colonel's
attorney. He manages all
of the Colonel's business
affairs and accounts. He
seems rather sneaky, and
it is said that he lusts after
the Colonel's money.

Dr. Wilbur C. Feels
Dr. Feels is the Colonel's
long time personal
physician. He is known
for his lecherous ways,
and his questionable
medical practices.

Jeeves
Jeeves is the Colonel's
tall, sijent butler. Very
imposing and solemn,
he s not terribly friendly
or helpful. What is he
really after?

Fifi is the Colonel's sexy
French maid. It is
rumored that she and the
Colonel are involved in a
relationship of a
somewhat more than
domestic nature. Most of
the family are of the
opinion that Fifi is using
the Colonel to get at his
money.

Celie
Celie is the Colonel's
cook. She is quite
superstitious and
somewhat reserved, but
she can be friendly and
helpful if approached
cautiously. It is said that
she dabbles in voodoo.



Beauregard
Beauregard is the
Colonel's dog. A lazy old
bloodhound, he can be
observed lying near his
doghouse most of the
time.

Blaze
Blaze is the Colonel's old
horse. Like the Colonel,
he's a veteran pf the
Spanish-American war,
but now rarely leaves the
comfort of his stable.

Polly
The Colonel's parrot sits
on his perch in the parlor.
He talks when he's in the
mood, or when properly
motivated.

LILLIAN: Laura, I've just received an
reunion this weekend.

LAURA: (seemingly-absorbed m-Ker st

'LILLIAN: Yes, I suppose;! am. (looks
Maybe you'd like to come along! Uncle
middle-of the bayou. Someone like you

LAURA: I don't know, Lillian. I really

LILLIAN: Oh, come on Laura, it'll be

(pause) V . ' : :• • • • _ • : '

LAURA: (looking up and closing her b
be more fun than reviewing for my bioli

.LILLIAN: £>h, we're/going to have sue



The Colonel's parrot sits
on his perch in the parlor.
He talks when he's in the
mood, or when properly
motivated.

ACT I
SCENElr
Scene: j)ay. Campus commons, Tulane
University in New Orleans, Louisiana in the
year 1925, during a class break. LAURA
BOW sits upon a bench, center stage,,
reading a textbook. LILLIAN PRUNE
stands near LAURA, also center stage. .

LILLJAN: Laura, I've just received an invitation to, visit my" Uncle Henri's estate for a family.,
feunipft this weekend.

LAURA; (seemingly-absorbed in-Ker studies) That sounds nice, Lil You must be so.eXcited:

' LILLIAN:-Yes, I suppose'! am. (looks slightly puzzled, then her face suddenly lights up)
Maybe you' d like tp come along! Uncle. Henri' s mansion is on a private island, fight in 'the
rniddle-of the bayou. Someone like: you should find i<ifascinating\

LAURA: I don't know, Lillian. I really should study. : ;

LILLIAN: Oh,.come on Laura/it'll be fuh! '

(pause) .7 /--i" ...-^'V '
: LAURA: (looking up and closing her book)We\\, I'suppbse it wbn't hurt. At any rate it should
bembrefun than reviewing fpf my. biblbgy exam. ; :

 ;.

.LILLIAN: Qh, we're,going to have such a time. You won't regret it, .Laura!. .

Scene: Night. A dark and misty bayou .'•
LAURA and LILLIAN skim through the
gloom aboard a small skiff. A tall and
silent BLACK MAN pilots them. The
silence, is broken occasionally by the eerie
cry of a nigntbird. Finally the form of a
grand .house becomes discernible through
the dense trees. The skiff comes to a halt
at a small dock, and the girls disembark.
Without a word, the BLACK MAN turns
the boat around and is quickly lost in the
dark mists of the bayou. LAURA watches
until she can no longer see. him: -



SCENE in Viy-•;";'"•'
Scene: An island in the swamp, on the
unkempt grounds of Colonel Dijon's estate.
An ominous looking, run down old mansion
is visible in the background. LAURA and
LILLIAN are walking toward the house.
LAURA looks around continuously, as if she
expects something to jump out of the
shadows. She jumps when LILLIAN speaks.

LILLIAN: Well, what do you think, Laura?

(JEEVES steps aside and gestures for th
into the house. , .

-.' LAURA: (clutches her chest, then seems to
' catch her breath) It's not exactly what I . .

expected (looks around), but it looks interesting, all right (shivers), ,'.

(Pause as the girls walk insijence for a moment.)

LILLIAN: Uncle Henri was a colonel in the Spanish-American war; you know. In factv he still.
prefers to be called Colonel Dijon.. I don't call him that, though— to me he's my dear old
Uncle Henri. \

.(LlLLIAN-pauses, Looks wistful, as though recalling fond memories.)

LILLIAN: He's a peculiar old bird, though. He covets his privacy and detests being.bothered.
That's why he bought this place (gestures about them). When I was a little girl, he would
invite me to visit him here in the summers. Looking back, it seems that! was the Only one in
Ihe family that he really cared about. That's why I'm puzzled about this 'family reunion*. I-
never would have expected a family gathering at Uncle Henri's*

SCENE IV -;:-f.:v?/;
Scene: The large front porch of the Dijon
mansion. LILLIAN and LAURA stand
center stage before an immense door. On-the
door are two huge door knockers,

LILLIAN: (reaches for one of the door ;
knockers, giggles) Kirida; creepy, isn't it?

(LILLIAN brings the door knocker down
with aloud BANG! and again BANG! A

• short pause, then: the door creaks open to
revealJEEVES, the tall gaunt butler :)y

JEEVES:.(ina deep', imposing voice) Yeeesss?.; . :'.

(LAURA gapes at the formidable butler) • '_

LILLIAN: (smiling) Jeeves, it's me, Lillian \ ,\.don't youRemember?., - '

JEEVES: Qhhh/yesss, Well, everyone else has arrived and they're assembling in the dining
roOm. Please come inland join them: • >>•:'. :

'C. FEELS, the COLONEL'S long time pi
'to the other guests. They are largely uriplt
meal. At last, dessert is served.

(Enter COLONEL DIJON inawheelch
..She parks him at the head of the long taf

COLONEL DIJON: (nods tersely, and
here. I'm sure you're all wondering why

(pause,as DUOHclearsMs thrp.dt)

COLONEL: DIJON: As'-you know, lar
• is near, and so*I have decided to bequeat

(pause, as DIJON appears to notice LAI

COLONEL DIJON: Who are you, dear

LAURA: (nervously) Oh, I beg your pai
Lillian's. Would you like me to leave tto

COLONEL DIJON; No; no, just sit wh
Qh, yes. AHEM! As I was saying, each i
well you'll all inherit EQUALLY upon i
then, your share will be divided equally'i

(pause, as DIJOISI surveys his guests, ap,
', one.imothef suspiciously.).

COLONEL DIJON: I'm tired.iFifi. He
'.guests). If you'HaH excuse me, I'm goit

morning., Have a pleasant night. .

(DIJO-N''signals FIFI; who turns hitn arc
• silence until DUON is gone,): :-:
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tmefican war, you know. In fact; he still
.though— to me he's my dear old

(JEEVES steps aside and gestures for the two girls to enter. LAljRA and LILLIAN proceed
into the house. ;••.• ••

SCENEY - . • .? ' : ; ' ;••
Scene: The dining room of the Dijon
mansion. A fire is ablaze in the fireplace,
upstage center. An enormous dining table,
splendidly set, occupies center stage.
Seated at the table are LAURA;
LILLIAN; ETHEL PRUNE, LILLIAN'S
mother; GERTRUDE DIJON, widow of
the COLONEL'S late brother; GLORIA
SWANSONG, GERTRUDE'S daughter
and the COLONEL'S niece; RUDOLPH
DIJON, GERTRUDE'S son, GLORIA'S ;
brother and the COLONEL'S nephew;
CLARENCE SPARROW, the
COLONEL'S attorney; andDR, WILBUR

.C. FEELS, the COLONEL'S long time personal physician. During dinner, LAURA is introduced
'to the other guests. They are largely unpleasant, and bicker amongst themselves throughout the
meal. At last, dessert is served.

nd memories.) . • , '
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(Enter COLONEL DIJON in. a wheelchair. He is being aided by FIFI, 'his sexy blonde maid. -
..She parks him at the head of the long table-)

COLONEL DIJON: (nods tersely, and-speaks'in a gruff voice) I'm glad to see-that you're all
here. I'm sure you're all wondering why I've asked you. _ . :

(pause,'as DIJON clears his thradt) :

COLONEL; DIJON: As-you kpow, I am a very wealthy man.; Unfortunately, I believe my end
• is near, and so'I have decided td bequeath my many millions to each of you.:.

(pause, as DIJON appears to notice LAURAfor the first time) .

COLQNELDIJON: Who are you, dear?"-•

LAURA: (nervously) Oh, I beg your pardon sir, my name is Laura Bow --' I'm just a friend of
Lillian's. Would you like me to leave the room while you talk about this?'

COLONEL DIJON; No, no, just sit where you are, I'm nearly finished. Now where was I? •;-:
Oh* yes. AHEM! As I was saying, each of you here, except for Miss . . . ah. Bow is it? Yes,
well you'll all inherit EQUALLY upon my demise: If any of you should expire before I do,
then your share will be divided equally'arnong the surviving parties. :

(pause, as DIJON surveys his guests, appafentty letting his words sink in: The guests look at
', oiie Another suspiciously:).

COLONEL DIJON:: I'm tired,.Fifi. Help mie to my room (looks again at the assembled
' .guests). If you'll all excuse me, I'm going to retire.for the evening. I will seJeiypii'ailinthe
morning. Haye a pleasant night.

(DIJON ~.*si'gnat$;1*f&,'whp''tur.ns him around and wheels him fromthe woni. The.group sits in
silence'until DIJON "is gone,) :;.-



•GERTRUDE: Can you believe that?

RUDY"; The old goat.

GLORIA: I'm surprised he didn't try to take it.with him, he's such an old skinflint!-

RUDY: I don't think YOU deserve any money!

GLORIA: Speak for yourself!

CLARENCE: How.much dp you think he's got?

WILBUR: Well, I know what I'm gdingio do with MY share,!

CLARENCE: YOUR.SHARE?! Ibet the:old codger outlives YOU!

GERTRUDE: I wonder how sick he M

ETHEL: Do you think he'll go soon?:

LILLIAN: (standing abruptly) I've had enough of this! Lauraand I will retire to pur room
now.

(exit LAURAianrf LILLIAN);

•'• SCENE vr V f , : .;•/;;-.
Scene: Guest room shared by LILLIAN
and LAURA. Two beds occupy upstage
right and downstage right. A small couch
sits downstage center and near it, an
armchair. A large portrait of COLONEL
DIJON hangs upon the watt above the
fireplace, upstage center. LILLIAN opens
her suitcase and rummages through it.
LA URA surveys, the room.

LILLIANSWill you excuse me, Laura?
I'm going to freshen up a bit. Please

make yourself at home and feel free to explore!

LAURA: Thank you Lil, Imay .dp just that.

•(LILLIAN flounces out of the room, leaving Laura alone. LAURA wanders around the room
for a short time, examining closets, drawers and various objects, then ventures out into the
enormous mansion.) : , •• ';.; •':•:•

ON WITH THE SHOW V : . .

As usual, Laura's curiosity has gptteji the better pfher. In this ease however, I'm
afraid she may be in a little over her head. Let's jpin her now, befpre the real fun
begins. Maybe we'll be intime to^^be ofsome assistance tobjer assheattiemptsto
solve the mystery of v.. THECOLONEL^S REQUEST!
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HOW TO READ THIS MANUAL
Throughout this manual we will be using the following ways of representing information:

MENU COMMANDS will be capitalized.
Example: SAVE, RESTORE, QUIT, PAUSE

Typed commands will appear as bold type.
Example: 'type: ask lillian about ethel'
'type: cd \sierra'

Portions of the command line not meant to be typed will not appear in bold type. For
example, in the line 'type: cd \sierra', 'type:' should not be typed.

[Example text] and [Keystrokes] will appear in brackets setting them off from the
surrounding text. The brackets ([]) are not keystrokes and should not be typed.

Example: [object], [character], [Spacebar], [Tab], [PageUp]

Two or more keys that should be pressed at the same time will be separated by a hyphen
(-). This hyphen is not a keystroke, and should not be typed.

Example: 'Press [Ctrl-I] to view your inventory.'

If a space appears between parts of a command, it is meant to be typed.
Example: 'type cd \sierra' (the space between cd and \sierra should be typed as part of
the command.

The term 'diskette' is used to refer to either 5.25" or 3.5" data storage disks.

ALL SYSTEMS
PLEASE NOTE: It is important that you view the README file on your game disk as it
may contain important information and instructions that were not available at the time
the documentation and other materials for this game were printed. Failure to review the
README file before installing the program may result in unexpected consequences
during the installation and/or running of the program.

MS-DOS README INSTRUCTIONS
To view the README file from DOS, type: readme. If the file is longer than one screen, Use
[Page Up]/[Page Down] to scroll through the file one screen at a time.

ATARI ST README INSTRUCTIONS
To view the README file from the desktop, double-click on the README.DOC icon. You
will see a message box with choices for SHOW, PRINT, and CANCEL. Choose SHOW to

1

view the file one screen at a time. Press £
print the file. Choose CANCEL to escape

AMIGA README INSTRUCTK
Insert WorkBench disk into drive DFO: ai

Users with one drive: Copy the 'type' c(
owner's manual for instructions. Insert g;

Users with more than one drive: Insert
drive DF1:. Type cd DF1:. Type: type re

GETTING STARTED: DISKET1
It is always advisable to make back-up cc
life of the masters and guard against accii
copies of all game diskettes.

Even if you will be playing from a hard c
saving games. Follow your computer's ir
handy for saving your game as you play.
'Saving Your Game' (Page 9) and 'Inten
of this manual.

When installing your program, you may 1
this prompt, please examine your disks at
[ENTER], so that the appropriate drivers
'Drivers' disk.

INSTALL THE GAME
Place the back-up copy you have made o
drive you have placed the diskette into fo
[ENTER]. Type: install and press [ENTI

Answer the onscreen questions using the
selections, then press [ENTER] to select,
your hard disk. If you do not wish the gai
skip this step. If you want to install the g;
your hard disk (usually C) and follow the

Please note: Even if you install to a hai
named RESOURCE.CFG to disk 1. Fo
1 MUST NOT BE WRITE PROTECT
by the install command.
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f the file is longer than one screen, Use
:reen at a time.

ick on the README.DOC icon. You
F, and CANCEL. Choose SHOW to

view the file one screen at a time. Press [ENTER] to see the next screen. Choose PRINT to
print the file. Choose CANCEL to escape the message box.

AMIGA README INSTRUCTIONS
Insert WorkBench disk into drive DFO: and turn on your system. Double-click on the CLI icon.

Users with one drive: Copy the 'type' command into your RAM disk. See your Amiga
owner's manual for instructions. Insert game disk 1. Type: type readme.

Users with more than one drive: Insert WorkBench in drive DFO:. Insert game disk 1 in
drive DPI:. Type cd DF1:. Type: type readme.

GETTING STARTED: DISKETTE DRIVES
It is always advisable to make back-up copies of your master program diskettes to increase the
life of the masters and guard against accidents. Follow your computer's instructions to make
copies of all game diskettes.

Even if you will be playing from a hard disk, you may also want to format a blank disk for
saving games. Follow your computer's instructions to format a blank diskette and keep it
handy for saving your game as you play. For some helpful tips on saving games, see the
'Saving Your Game' (Page 9) and 'Interacting with The Colonel's Bequest' (Page 9) sections
of this manual.

When installing your program, you may be prompted to insert a 'Drivers' disk. If you receive
this prompt, please examine your disks and insert the disk marked 'Drivers' and press
[ENTER], so that the appropriate drivers will be loaded. Some games do not include a separate
'Drivers' disk.

MS-DOS

INSTALL THE GAME
Place the back-up copy you have made of disk 1 into your diskette drive. Type the letter of the
drive you have placed the diskette into followed by a colon (for example: a:), and press
[ENTER]. Type: install and press [ENTER].

Answer the onscreen questions using the up and down [Arrow] keys to highlight your
selections, then press [ENTER] to select. You will be asked if you wish to install the game on
your hard disk. If you do not wish the game to be installed on your hard disk, press [ESC] to
skip this step. If you want to install the game on your hard disk, enter the letter designation of
your hard disk (usually C) and follow the prompts.

Please note: Even if you install to a hard disk, the install procedure will write a file
named RESOURCE.CFG to disk 1. For the installation to be completed correctly, DISK
1 MUST NOT BE WRITE PROTECTED. No other files on disk 1 are written or changed
by the install command.



LOADING INSTRUCTIONS
After completing the INSTALL procedure:

From diskettes:
1. Place Disk 1 into the A drive.

2. Type: a: and press [ENTER].

3. Type: sierra and press [ENTER].

From hard disk:
1. From your root directory, type: cd \sierra and press [ENTER].

2. Type: cb and press [ENTER].

SAVING GAMES TO DISKETTES
PLEASE NOTE: If you're playing from diskettes, you must have a separate formatted
diskette ready before you can save a game. Since each diskette can only hold a limited
number of games, we recommend that you have more than one formatted in order to
assure adequate space for save game storage.

l.Choose SAVE GAME from the File menu,or press the [F5] key. The Save Game menu
will appear.

2.Use your [Tab] key to choose CHANGE DIRECTORY. Backspace or press [Ctrl-C] to
clear the command line.

3. Type the letter of the drive you are using for saved games, followed by a colon
(Example: a:) and press [ENTER].

4. Type the name of your saved game and press [ENTER] to complete the SAVE GAME
procedure. If your disk for saving games is full, you may reformat it (this will erase the
saved games on the disk) and use it over, or use another formatted blank disk.

SAVING GAMES TO HARD DISK
If you choose to save games to the hard disk, the program will automatically try to save to the
game's own directory. If you run out of space for saving games, try one of the following
alternatives:

1. Save additional games to a diskette.

2. Save games to a different directory by using your [Tab] key to choose CHANGE
DIRECTORY from the Save Game menu (inside the game).

3. Delete the saved games and tl
DOS instructions (outside the gi
games.

4. Create a new hard disk direct!

LOADING INSTRUCTIONS
Note: If you are using an Atari 520 S
accessories (rename .ACC extension

1. If you are playing the game fr
double-clicking on its icon. Stan

2. If you are playing the game fr
icon, then open the game folder
game by double-clicking on SIE

HARD DISK INSTALLATION"
Please note: More than 512K of memc
disk.

1. Open the hard disk by double-

2. Create a game folder by chooi
new folder by double-clicking 01

3. Place Disk 1 in drive A:.

4. Copy the game disk into the n
window you opened in Step 3.

5. Repeat steps 3 and 4 for each

6. Put the master disks away in a

CHOOSE A MUSIC DEVICE (
Your Sierra game is initially set up to |
speaker. If you have one of the supporl
program to have the game play music I

1. Open the game disk/folder by

2. Run the MUSIC program by d



1 press [ENTER].
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press the [F5] key. The Save Game menu

BCTORY. Backspace or press [Ctrl-C] to
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[ENTER] to complete the SAVE GAME
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3. Delete the saved games and the save game directory from your hard disk by following
DOS instructions (outside the game). The program will create a new directory for your
games.

4. Create a new hard disk directory from DOS, using DOS instructions.

ATARI ST

LOADING INSTRUCTIONS
Note: If you are using an Atari 520 ST without memory expansion, turn off all desk
accessories (rename .ACC extension .ACX) before running your Sierra game.

1. If you are playing the game from diskettes: place Disk 1 in drive A, open the disk by
double-clicking on its icon. Start the game by double-clicking on SIERRA.PRG.

2. If you are playing the game from a hard disk: open the disk by double-clicking on its
icon, then open the game folder by double-clicking on the game folder icon. Start the
game by double-clicking on SIERRA.PRG.

HARD DISK INSTALLATION
Please note: More than 512K of memory is needed to run Sierra games on your Atari ST hard
disk.

1. Open the hard disk by double-clicking on its icon.

2. Create a game folder by choosing NEW FOLDER... from the File menu. Open the
new folder by double-clicking on its icon.

3. Place Disk 1 in drive A:.

4. Copy the game disk into the new game folder by dragging the drive A: icon into the
window you opened in Step 3.

5. Repeat steps 3 and 4 for each of the other game disks.

6. Put the master disks away in a safe place.

CHOOSE A MUSIC DEVICE (Optional)
Your Sierra game is initially set up to play music and sounds through the Atari ST's internal
speaker. If you have one of the supported MIDI synthesizers, you may run the MUSIC
program to have the game play music through the synthesizer.

1. Open the game disk/folder by double-clicking on its icon.

2. Run the MUSIC program by double-clicking on the MUSIC.PRG icon.



3. Select MUSIC DEVICE from the Options menu.

4. Select your synthesizer (or ATARI ST INTERNAL SOUND) by clicking on the
appropriate button, and click on OK.

5. Select INSTALL GAME from the File menu. This will replace the RESOURCE.CFG
file on your disk.

Please note: It is important to turn on your synthesizer before starting the game.

AMIGA

INSTALLING THE GAME
NOTE: RENAME your copies of all game disks to remove the words 'COPY OF' from
the disk name. If the words 'COPY OF' are not removed from the disk names of ALL the
copies, the system will continue to ask for the original disk, and will not run the game.

1. Boot your system with WorkBench, and insert Disk 1 of your Sierra game.

2. double-click on the disk icon, then double-click on the INSTALL icon.

3. Follow the onscreen prompts, choosing your selection with the mouse by clicking
once on the item.

4. You will be asked if you wish to install the game on your hard disk. If you do not wish
the game to be installed on your hard disk, select NO. If you want to install the game on
your hard disk, select YES.

5. Using your mouse, select which hard drive you wish to install the game onto.

6. Follow the onscreen prompts to complete the installation.

LOADING INSTRUCTIONS

From Floppy Diskettes:
1. If you have less than 1 megabyte of memory for your Amiga, turn your system off and
disconnect any external drives.

2. Insert Disk 1 into drive DFO:

3. Turn on your system.

From Hard Disk:
1. Load WorkBench and double-click on your hard disk icon.

2. Double-click on the SIERRA C

3. Click on the drawer for the des

4. Click on the game icon.
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your Amiga, turn your system off and

2. Double-click on the SIERRA GAMES drawer.

3. Click on the drawer for the desired Sierra game.

4. Click on the game icon.

ALL SYSTEMS

PLAYING THE GAME
MOVING YOUR CHARACTER
You may move your character on the screen with the [Arrow] keys, the numeric keypad, or the
mouse. To halt your character's steps with the keypad, press the number 5, or press the last
used direction key again. Do not attempt to move the character by holding down the
direction key. This will cause the character to start and stop continuously, resulting in
very slow progress.

Using the mouse, position the arrow to where you want the character to move, then click the
left mouse button.

NW NE
\

"0130
Stop

sw

disk icon.

GAME SPEED CONTROL
At times it may be useful to slow down the speed of the game animation in order to negotiate a
tricky section, or observe something more carefully. In The Colonel's Bequest, speed is
controlled by the [+] and [-] keys, or by selecting a choice from the Speed menu, using the
mouse or [Arrow] keys.

MENUS
The Menu Bar in The Colonel's Bequest is not visible during play. When you press [ESC], the
Menu Bar will appear at the top of your screen with several menus which can be opened to
show the command choices available to you.

KEYS TO USE IN THE MENUS
Use the left and right [Arrow] keys to open a menu, and the up and down [Arrow] keys to
highlight items within a menu. Press [ENTER] to select a highlighted command. Press [ESC]
to return to the game without choosing a command.



SHORT CUTS FOR COMMON COMMANDS
You can use function and control keys to short cut many common commands.

[Fl]

[F2]

[F3], [Spacebar]

[F5]

[F7]

[F9]

[Tab]
[ESC]

[Ctrl-C]

[Ctrl-I]

[Ctrl-P]

[Ctrl-Q]

[+]

l - l

[=]

[Ctrl-V]

[Shift-Click]

Help

Toggle sound on/off

Repeat previous command

Save Game

Restore (saved) Game

Restart Game (from beginning)

Inventory

Show Menu Bar, Pause Game

Cancel typed command line

Inventory

Pause Game

Quit Game

Increase Speed

Decrease Speed

Normal Speed

Change Volume

Look at an object (see below)

SHIFT-CLICK
SHIFT-CLICK is a feature which will allow you to look at a person, place or object using your
mouse. Place the mouse arrow on the desired person, place or object, then hold down the
[Shift] key and press the mouse button. You will now receive a descriptive message.

* Please note: Multi-button mouse users should use the RIGHT mouse button and need not
press [Shift].

USING YOUR TAB KEY
While playing Sierra games, your [Tab] key will perform two major functions. You will use it
to review the items in your inventory, and also (if you're not using a mouse) to select options
from certain menus. The following menus will require the use of the [Tab] key for highlighting
menu options:

MENU CHOOSE FROM

3. Quit Game

4. Save Game

5. Restore Game

6. Death Window

Qu

Sa1

Re
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3. Quit Game

4. Save Game
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Quit, Continue

Save, Change Directory Cancel, Replace

Restore, Cancel, Change Directory

Restore, Restart, Quit

USING THE MOUSE (optional)
Your mouse will be useful to you in moving your character, and in learning about your
surroundings. To move your character using the mouse, position the arrow to where you want
the character to move, then click the mouse button. If your mouse has more than one button,
use the left button.

EXAMPLES OF COMMON COMMANDS
Many characters in the game will have information of one kind or another for you. To talk
with a character, type: talk to [character], ask (or tell) [character] about [character or object].
For example: talk to gertie, tell the colonel about lillian or ask lillian about the [object]. Try
different approaches. 'Show' an object to someone, and they may give you valuable
information. 'Asking' a character about something may evoke a different response than
'telling' them.

You may encounter objects you need along the way. To take an object, type: take (or get) the
[object] for example: take the note, or get the key.

Pay close attention to details. To look closely at objects, type look at the [object], for example:
look at the table. You can also use the [Shift-Click] feature described on Page 7.

You will need to use the objects you acquire as you explore. You can try different things such
as typing: use the [object], or give the [object] to [character] or show [object] to [character].
Different approaches to a puzzle may bring about a different outcome.

RETYPING COMMANDS
If you wish to repeat a command, select RETYPE from the Action menu or press the
[Spacebar] or [F3].

INVENTORY
If you wish to see the items you are carrying, select INVENTORY from the Action menu, or
press [Ctrl-I] or [Tab]. A list of the items you are carrying will be displayed. To view an
object, click on its name with the mouse, or use the [Arrow] keys to highlight the name and
press [ENTER]. Press [ENTER] again, select OK or press [ESC] to resume play.

PAUSING YOUR GAME
If you wish to pause the game, select PAUSE from the Action menu, or press [Ctrl-P] or
[ESC]. Press [ESC] or [ENTER] to resume play.



SAVING YOUR GAME
If you wish to save your game, select SAVE from the File menu or press [F5]. To allow for
errors in judgement and creative exploration, we recommend that you frequently save your
game in progress, and that you save several different games from different points as you play.
You will always want to save your game before encountering potentially dangerous situations.
You should also save your game after you have made significant progress.

PLEASE NOTE: If you're playing from floppy disks, you must have a separate
formatted disk ready before you can save a game. We also recommend that you create
several directories or folders on your save game disk in order to assure adequate space
for save game storage.

If you choose to save games to your hard disk, we suggest that you create one or more save
game directories or folders on your hard disk. See your computer's instructions for creating
directories or folders.

You may name your saved games using standard English phrases. For example, if you are
standing on a sandy beach, you might call your game standing on a sandy beach, or simply
beach.

RESTORING YOUR GAME
Select RESTORE from the File menu, or press [F7]. You will be prompted to select the game
you wish to restore. (On a single drive system, you will be prompted to insert your save game
disk). Highlight the desired game and select RESTORE. If the game you wish to restore is in a
different directory, select CHANGE DIRECTORY.

QUITTING YOUR GAME
If you wish to stop playing, select QUIT from the File menu, or press [Ctrl-Q].

RESTARTING YOUR GAME
If you wish to restart your game at any time during play, select RESTART from the file menu,
or press the [F9] key. The game will begin again in the guest room shared by Lillian and Laura.

INTERACTING WITH THE COLONEL'S BEQUEST
You can generally interact with the game by typing simple commands consisting of as little as
a noun and a verb. For instance, the command get into the car can be shortened to get in car.
Unless otherwise instructed, follow all commands with [ENTER].
The Colonel's Bequest will understand many common verbs. Here are some you might try:

LOOK CLIMB OPEN STAND
GET PUSH CLOSE GIVE
READ PLAY PULL EXAMINE
LOAD TELL SHOOT JUMP
TALK USE MOVE TAKE
PRY ASK SHOW
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/erbs. Here are some you might try:

STAND
GIVE
EXAMINE
JUMP
TAKE

A message window will appear each time you enter a command, and at other times during the
game. When you have read the message, press [ENTER] to remove the window and resume
play.

TAKE NOTES as you discover clues and information. Record anything you think might be
important. Make a note of each area you visit, and include information about objects found
there, and dangerous areas nearby.

DRAW A MAP as you progress through the game. If you miss an area, you may miss an
important clue!

WATCH THE CLOCK. As you progress through the game, a clock will periodically appear
on your screen. Take note of the event and location when this occurs. This will help you to
keep track of your progress.

LOOK EVERYWHERE. When you enter a room for the first time, you will receive a
message on your screen describing the room. When you visit the room again you will need to
type: look around or look room to get the description. Look closely at all objects you
encounter.

EXPLORE each area of the game very carefully, and be on the lookout for clues and hidden
places. Search every area of the mansion and the grounds surrounding it. Re-visit an area
frequently, and make note of anything that has changed. Something may occur in an area while
you are elsewhere.

TALK to everyone you meet, but use discretion! Some characters will be friendly and helpful;
they may give you valuable information and advice. Others may mislead you. Try various
approaches in dealing with others. If talking to them or asking them questions yields few or no
results, show them something interesting you have found. They may have a comment that will
help you.

LISTEN closely to conversations. Useful information will pass between the other characters,
and you'll want to pay attention to details that may help you with your investigation.

PICK UP anything that isn't nailed down. You will come across a number of objects that may
be of use to you later. You can see an inventory of items on hand by pressing the [TAB] key at
any time.

USE the items you have picked up to solve problems in the game, or to help you to make
progress and discover more clues.

BE CAREFUL, and remain alert at all times - disaster may strike in the most unlikely of
places.

SAVE YOUR GAME OFTEN, especially when you are about to try something new or
potentially dangerous. This way, if the worst should happen, you won't have to start all over
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again from the beginning. It is probably best to save at least one game in each act of The
Colonel's Bequest, so you will be able to return to a desired point in the game. In effect, this
will enable you to travel backward through time and do things differently if you wish. After
you have restored a saved game, take note of the time of night. Refer to your notes; you will
need to repeat some actions to insure that other events will take place as they should.

DON'T GET DISCOURAGED. If you come to an obstacle that seems insurmountable, don't
despair. Spend some time exploring another area, and come back later. Every problem in the
game has at least one solution, and some have more than one. Sometimes solving a problem
one way will make it harder to solve the next, and sometimes it will make it easier. If you get
stuck, you might try restoring a saved game from an earlier point, then choosing a different
path. If all else fails, you can buy The Colonel's Bequest hint book from the dealer who sold
you the game, or you can order directly from Sierra On-Line by calling (800) 326-6654.

BRING ALONG SOME HELP. You might find it helpful (and fun) to play the game with a
friend. Two (or more) heads are better than one at interpreting clues and solving problems.

NEED A HINT?
If you find yourself 'a little stuck' while playing a Sierra game, try the following ideas:

1. If you have a modem, you can talk to the Sierra Bulletin Board through the following
number:

(209) 683-4463
Our settings are 300, 1200 or 2400 Baud; 8 Data; N Parity; 1 Stop Bit. Our sysop will be
happy to help you.

2. Many other bulletin boards also provide hints to many of our games.
A. CompuServe: Go into the Gamers Forum (GO GAMERS) or write E-Mail to
76004,2143.
B. Prodigy: Write E-Mail to 'HTWS90E', or go to the PC Club and enter the
adventure games forum (Jumpword: PC CLUB).
C. PCLink: Select PCLink Plus, enter Publisher's Connection, select Publishers
Forums, then Sierra On-Line. E-Mail may be written to the User ID 'Sierra On Li'.
D. AppleLink: Select the KEYWORD option from the 'Goto' menu, and type:
Sierra. E-Mail may also be written to the User ID 'Sierras'.
E. GEnie: From the main menu select 10 (Games), then select 1 (Games Round
Table). Select 1 (Games Bulletin Board), and type set 22 at the '?' prompt. This
will take you into the Sierra On-Line area.
For more information on these BBS lines, you can call these toll-free numbers:

1. CompuServe (800) 848-8199

2. Prodigy (800) 822-6922

3. PCLink (800)458-8532
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Type: look at the portrait [ENTER]





Type: look at the bed [ENTER]

After you read the response, walk south and east to stand in front of the northern-most bed.
There is a suitcase on the bed.

Press the [TAB] key.

Type: open the suitcase [ENTER]

Read the description of its contents.

Press the [TAB] key.

Walk thru the door on the east wall and enter Ethel's guest room.

Type: look at the shelves [ENTER]

Type: look at the doll house [ENTER]

Type: take the bear [ENTER]

Walk north and stand near Ethel.

Type: talk to ethel [ENTER]

Type: ask ethel about lillian [ENTER]

Exit Ethel's room through the door on the west wall, and enter your guest room.

Exit through the west door and enter the hallway.

Type: look at the marble statue [ENTER]

Type: look at the armoire [ENTER]

Type: look in the armoire [ENTER]

Walk north and enter the bathroom.

Type: look at lillian [ENTER]

Type: look at the tub [ENTER]

Walk to the sink.

Type: wash hands [ENTER]

Exit the bathroom, and re-enter the hallway.

Continue west across the hallway.

North of the armoire is a door on the west wall. Go through the door and enter the Colonel's
room.

Type: look at the elevator [ENTER]

Type: open the elevator gate [ENTER]

Type: look at the fireplace [ENTER]

Type: look at fifi [ENTER]

Type: look at the colonel [ENTER]

Stand near the Colonel.

Type: tell the colonel about lillian [El

After he responds, exit the room to the

This might be a good time to save youi

Walk south and you will see a banniste
Stand up against the damaged area.

After you fall to your death, restore yoi
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ugh the door and enter the Colonel's

Type: look at the colonel [ENTER]

Stand near the Colonel.

Type: tell the colonel about lillian [ENTER]

After he responds, exit the room to the east, and re-enter the hallway.

This might be a good time to save your game. See 'Saving your Game' for instructions.

Walk south and you will see a bannister with several dowels missing from an area on the left.
Stand up against the damaged area.

After you fall to your death, restore your game and continue exploring the estate...but be
careful!

PROBLEM DISK?

TECHNICAL HELP (MS DOS ONLY)
If you are having problems with a game disk, try these suggestions before assuming the disk is
faulty:

If you receive any of the following messages:
1) 'Insert Disk (#)' when you have already inserted that diskette, or have installed the
game on your hard disk

2) 'Out of Handles' or 'Out of Heap', or if the game locks up at any point

3) 'Disk Error'
You may have memory resident programs loaded into your RAM memory. You will need to
boot your system from a diskette containing your operating system only. Follow these
instructions to create a 'Sierra Boot Disk'.

Format a blank disk with DOS system files (using /s) to make a bootable disk.
FORMATTING FROM A HARD DRIVE

A) Place a blank disk in drive a:

B) At the C prompt, type: format a:/s
NOTE: If your A: drive is a high density drive and you are using double density disks, you will
need to type: format a:/4/s (for 5.25" disks)or type: format a:/n:9/s (for 3.5" disks)
FORMATTING FROM A DISKETTE DRIVE

A) Place your original DOS disk in drive A.

B) At the A: prompt, type: format a:/s (be sure to switch to a blank disk when
prompted by the FORMAT program.)

NOTE: If your A: drive is a high density drive and you are using double density disks, you will
need to type: format a:/4/s (for 5.25" disks)or type: format a:/n:9/s (for 3.5" disks)
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C) Press [ENTER]

D) Respond to DOS prompts.
Now you should create a CONFIG.SYS file on your Sierra Boot Disk, with a files=20
statement. Follow these instructions to create this file:

A) Type: a:[ENTER]

B) Type: copy con config.sys[ENTER]

C) Type: files=20[ENTER]

D) Press [F6] [ENTER]
You should see the message: ' 1 File(s) copied'. You will now have to re-boot your computer
with your new Sierra Boot Disk in the drive. Turn your computer off then on, or press
[Ctrl-Alt-Del].

If this does not clear the above messages, call (209) 683-8989 for technical help. Our technical
staff will be happy to help you.

TECHNICAL HELP (ALL SYSTEMS)
Technical assistance is only a telephone call away. Call (209) 683-8989 for convenient,
person-to-person service, or if you prefer, you may request assistance by mail. If you choose to
write to us with your request, please state your computer type and the nature of your problem.

If you find that you need to send for replacement diskettes, send the original disk 1 in the size
you need (3.5" or 5.25") to:

Sierra On-Line

P.O. Box 485

Coarsegold, CA 93614

Attention: RETURNS

Be sure to include a note stating your computer type, and the size of diskette you need (5.25" or

We will gladly replace your program free of charge for the first 90 days of ownership
(please enclose a copy of your dated sales receipt with your request). After 90 days
there is a $5.00 charge for 5.25" diskettes, and a $10.00 charge for 3.5" diskettes.
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PLEASE
DO NOT MAKE ILLEGAL

COPIES OF THIS SOFTWARE
The software you are using was produced through the efforts of

many people designers, artists, programmers, distributors, retailers
and other dedicated workers.

The costs of developing this and other software programs are
recovered through software sales. The unauthorized duplication of
personal computer software raises the cost to all legitimate users

This software is protected by federal copyright law. Copying
software for any reason other than to make a backup is a violation of
law. Individuals who make unauthorized copies of software may be

subject to civil and criminal penalties.

'SIERRA
as a member of the Software Publishers Association (SPA), supports the industry's

ettort to tight the illegal copying of personal computer software

Report copyright violations to:
SPfl. T101 Connecticut flvma«, NW. Suite 901

Washington, DC Z0036

Limited Warranty Notice
Sierra On- Line, Inc. wants your continued business. If you fill out the
enclosed product registration card and return it to us , you are covered by our
warranty. If your software should fail within 90 days of purchase, return it to
your dealer of directly to us, and we will replace it free. After 90 days,
enclose $5 fir 5.25" disks (or $ 10 for 3.5s" disks) and return the software
directly to us. Sorry, without the registration card you are not covered by the
warranty. This warranty gives you specific legal rights which vary from state
to state.

Copyright Notice
This manual, and the software described in this manual, are copyrighted. All
rights are reserved. No part of this manual or the described software may be
copied, reproduced, translated, or reduced to any electronic medium or
machine-readable form without prior written consent of Sierra On-Line, Inc.,
P.O. Box 485, Coarsegold, CA 93614.
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